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Using	LOGPEEK	
Logpeek	is	a	PASSCAL	program	for	viewing	State	of	Health	(SOH)	files	from	zipped	
RefTek130	files,	raw	RefTek	files	or	.log	files	created	by	PASSCAL’s	rt2ms	program.	An	
overview	and	detailed	instructions	for	use	of	the	various	options	follows.		This	guide	uses	
logpeek	version	2015.148.	
	
Within this document: 
Commands, Top-level menu buttons, and General scripts are in bold. 
Command-line usage is highlighted yellow 
Second level menu button/options are italicized. 
URLs and email addresses are blue. 
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Introduction	to	using	logpeek	–	A	Basic	How-To	Guide	
	
Starting	logpeek	
	
Open	logpeek	by	typing	logpeek	in	a	terminal	window	or	by	selecting	the	PASSOFT	menu	in	the	
dock	and	clicking	on	the	logpeek	icon.	From	the	command	line,	use	logpeek	–c		(current	directory)	
to	open	files	in	the	current	working	directory	rather	than	the	default	directory	in	the	setups	file.	
Use	logpeek	-g	(full	window	display	flag)	if	you	are	having	problems	with	window	sizing	when	
switching	from	one	display	type	to	another.	The	–g	option	will	start	logpeek	with	the	main	program	
window	fully	within	the	display.	
	
Before	the	logpeek	GUI	opens,	the	Who	Are	You?	Popup	window	appears.	This	allows	the	program	
to	find	and/or	save	program	related	files	for	individual	users.	
	

The Who Are You? popup window	
 

The	first	time	the	program	is	run	on	a	computer	the	Really?	popup	window	appears	signifying	that	
no	setup	files	were	found.	Click	the	OK	button	to	start	the	program	and	initialize	the	user	ID.	
	

The Really? popup window 
 
Check	if	the	program	is	up	to	date.	Click	on	the	Help	button	at	the	top	of	the	GUI	and	select	Check	
For	Updates.	If	a	more	current	version	exists,	download	it	and	unzip	the	file.	Copy	the	file	
newlogpeek.py	to	/opt/passcal/lib/python/logpeek	and	change	the	name	to	logpeek.py.	You	
might	want	to	rename	the	old	version	logpeekOldVersion.py	or	something	similar.	Root	
permission	is	required.	Use	sudo	or	su	to	move	and	rename	the	file.	
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Loading	files	
	
Logpeek	remembers	the	last	directory	used	and	will	automatically	start	with	that	directory.	If	files	
are	located	elsewhere	use	the	Main	Data	Dir	button	in	the	upper	left	corner	of	the	GUI	to	navigate	
to	the	directory	containing	the	files	or	call	the	program	from	the	command	line	in	the	working	
directory	using	the	–c	option	as	mentioned	above.	Use	the	list	of	checkboxes	on	the	left	side	of	the	
GUI	to	control	the	types	of	files	(.log,	.ref,	.cf,	and	.zip).	Note	that	the	default	is	for	all	readable	file	
types	to	be	loaded.	To	view	a	disk	folder	add	.cf	(compact	flash)	to	the	filename.		

	
Check the type of files to view and Browse to the data directory 

Reload the files if adding or removing a data type after loading data 
 

The	Find	field	can	be	used	to	bring	a	specified	file	to	the	top	of	the	file	selection	list.	Once	a	file	is	
selected,	use	the	Read	button	to	open	the	file.	Multiple	files	can	be	selected	and	opened.	If	files	are	
from	multiple	dataloggers,	logpeek	will	open	a	popup	window	to	verify	that	it	was		intended	to	
open	files	from	different	dataloggers.	
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logpeek GUI with one data file selected and plotted 
	
Additional	data	streams	other	than	SOH	channels	can	be	viewed	using	logpeek.	Selecting	the	Only	
SOH	Items	option	will	force	logpeek	to	only	plot	the	SOH	channels	and	will	override	the	selection	of	
any	other	data	streams.	To	plot	mass	position	voltages,	check	the	appropriate	box	before	loading	
the	file.	logpeek	can	also	plot	raw	data.	Check	the	RAW	box	and	the	DSs:	1	(and/or	any	other	
programmed	datastream)	before	loading	the	data.	Mass	position	voltages	and	raw	data	are	
available	when	viewing	.zip,	.ref	or	.cf	files.	
	

Plotting mass positions and raw data from data stream 1 
	
To	load	a	.log	file	(or	several)	and	look	at	the	SOH	messages	without	plotting	the	SOH	data	you	can	
Shift-CTRL-click	on	the	file	to	open	the	SOH	messages	in	a	new	window	as	shown	below.		
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SOH messages window opened using Shift-CTRL-click on a .log file 
 
Hover	the	mouse	over	the	check	boxes	on	the	left	side	of	the	GUI	and	get	information	about	the	
functions.	The	command	buttons	are	not	set	up	for	pop-up	help.	

Hover the mouse to get information 
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Navigation	and	General	Usage	Tips	
	
Hover	the	mouse	over	the	Hints	label	in	the	upper	right	corner	of	the	GUI	and	a	yellow	window	will	
appear	with	various	user	hints	for	navigating	the	plotting	area.	
	
Zooming:	Zoom	in	by	shift-clicking	in	the	plotting	area	to	define	a	time	window	to	magnify.	Zoom	
out	by	shift-clicking	in	the	trace	label	area.	Look	at	the	message	in	the	status	barto	determine	
zoom	magnification.		
	

The display is at zoom level 2 
 

Scrolling:	Scroll	through	time	by	clicking	on	times	at	the	bottom	of	the	GUI.	Click	on	the	right	
(forward	in	time)	and	the	display	will	jump	90%	of	the	current	display	to	the	right.	Click	on	the	left	
(backward	in	time)	and	the	display	will	jump	90%	of	the	current	display	to	the	left.	
	
Add	Vertical	Time	Rule:	Display	a	Vertical	Time	Rule	by	holding	the	CTRL	key	and	clicking	in	the	
plot	window.	CTRL-clicking	at	the	far	left	of	the	plot	window	displays	the	time	rule	at	the	
beginning	of	the	plot	while	CTRL-clicking	at	the	far	right	of	the	plot	window	displays	the	time	rule	
at	the	end	of	the	plot	window.	
	

Use CTRL-click to display a vertical time rule 
Display	SOH	Messages	for	a	Data	Point:	Clicking	on	any	data	point	in	the	main	window	highlights	
the	message	for	that	point	in	the	SOH	Messages	window.	
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Remove	Data	Points:	Right-click	on	the	data	point(s)	to	make	them	disappear.	The	file	must	be	
reloaded	to	get	the	data	point(s)	back.	
 
Limit	Data	Range:	The	From	and	To	menu	boxes	at	the	right	of	the	directory	field	can	be	used	to	
limit	the	date	range	for	.ZIP,	.cf,	or	.ref	files.		Fill	in	the	dates	and	check	the	box	to	apply	the	required	
dates.	Use	the	C	box	to	view	a	calendar	that	can	display	the	dates	in	either	DOY	or	calendar	date	
format.	Entering	just	a	From	date	will	tell	LOGPEEK	to	plot	from	that	date	to	the	end	of	the	selected	
source,	and	likewise,	just	entering	a	To	date	will	plot	from	the	beginning	of	the	selected	source	to	
the	To	date.	The	plotted	times	are	from	00:00	on	the	From	date	to	24:00	on	the	To	date.	Simply	
uncheck	the	box	if	you	want	to	plot	the	entire	data	range.	NOTE:	this	option	does	not	work	with	the	
smaller	.log	files.	

  
Limit the amount of data displayed from large files by using the From: and To: fields 

	
Add	Grid	Lines:	CTRL-click	on	the	time	axis	to	extend	the	time	grid	lines	to	the	top	of	the	page	as	
shown	in	the	figure	below.	
	

Vertical time grid lines turned on by a CTRL-click on the time axis 
 
Menu	and	Main	Page	Commands	
	
This	section	gives	a	brief	overview	of	the	pull-down	menus	at	the	top	of	the	GUI.	
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The	File	Menu:		

 
The File pull-down menu options	
	
Delete	Setups	File	is	a	way	to	reset	the	program	if	the	current	setups	file	is	causing	problems.	The	
setups	file	tells	the	program	where	to	look	for	data	and	defaults	to	the	last	directory	used	by	
logpeek.	
Quit	closes	the	program.	
	
The	Commands	Menu:	

 The Commands pull-down menu options 
	
GPS	Data	Plotter	draws	a	scatter	plot	of	the	GPS	positions	from	the	selected	data	file.	Hover	over	the	
Hints	area	for	more	information.	Clicking	on	a	point	displays	the	time,	latitude,	longitude,	and	
elevation	in	the	status	window.	Use	the	Export	button	to	download	the	data	to	a	tab-delimited	file.	
Right	clicking	a	point	deletes	it	(an	outlier	for	example)	from	the	calculation.	Recover	the	deleted	
point	by	reloading	the	data	for	the	plot.	Duplicate	points	are	not	plotted.  
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GPS	Data	Plotter	

	
Log	Search	opens	a	pop-up	window	that	allows	you	to	search	the	SOH	messages	log.	This	is	a	quick	
way	to	search	but	does	not	show	the	messages	in	context	(see	figure	below).	Another	way	to	search	
in	the	SOH	message	file	is	to	use	the	Find:	option	in	the	SOH	Message	window.	

Commands/Log Search compared with the SOH Message Find 
	

Plot	Time	Ranges	of	Files	is	a	good	way	to	see	if	any	data	are	missing.	Choose	the	data	files	and	
logpeek	creates	a	plot	of	the	time	ranges	of	the	selected	data.	There	are	two	options	for	viewing	the	
data.	Click	on	the	radio	button	All	to	show	the	data	in	chronological	order	or	Each	to	simply	plot	the	
time	range	of	each	selected	station	without	a	time	scale.	This	option	may	be	helpful	for	spotting	
gaps	in	the	data.	The	small	green	ticks	represent	acquisition	on	and	the	red	ticks	acquisition	off.		
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Time ranges of selected data (using the All option) 
 

Time ranges of selected data (using the Each option) 
	
Plot	Position	from	Files	creates	a	simple	map	of	the	station	locations	on	a	latitude/longitude	grid.		
The	location	is	a	simple	average	of	the	2nd	five	GPS	fixes	found	in	the	log	file	(skipping	the	first	5	
fixes	ensures	the	early	fixes,	after	reboot	or	power	up	for	example,	do	not	affect	the	average).	

Map of selected stations using Plot Positions from Files	
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The	Plots	Menu:	
The Plots pull-down menu options 

 
The	Plots	pull-down	menu	lists	all	possible	SOH	values	available	for	plotting.	The	default	is	to	plot	
all	the	curves	except	for	Mass	Positions	(Check	the	boxes	as	described	in	the	General	Usage	section	
above	to	see	mass	positions).		Toggle	the	curves	on/off	and	the	display	will	replot	the	data	to	reflect	
the	changes.	Use	the	All	Plots	On	option	at	the	bottom	to	restore	all	the	curves.	
	
The	Options	Menu:	
The Options pull-down menu choices 
	
The	Options	pull-down	menu	customizes	a	number	of	parameters	as	shown	above.		Toggle	options	
on	or	off	by	clicking	on	them.	Helpful	options	are	to	Plot	Timing	Problems	that	will	plot	all	lines	in	
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the	SOH	files	even	if	the	timestamps	are	not	in	order.	Normally,	when	this	option	is	not	checked,	
logpeek	will	ignore	lines	that	are	time	stamped	earlier	than	preceding	lines.	The	lines	that	logpeek	
skips	are	displayed	in	yellow	in	the	SOH	messages	display.		
	
The	Forms	Menu:	

The Forms pull-down menu choices 
 

The	Forms	pull-down	menu	shows	the	logpeek	windows	that	are	open.	In	the	example	above	the	
GPS	Data	Plotter	window	is	open	as	is	the	SOH	Messages	window	for	the	specified	file.		
	
The	Help	Menu:	
The	Help	pull-down	menu	displays	the	options	for	program	Help	and	a	couple	of	other	useful	
features	as	shown	in	the	figure	below.	Get	information	about	the	configuration	and	version	by	
clicking	on	About.		

The Help pull-down menu choices 
 

The	Calendar	can	be	set	to	either	dates	or	day	of	year	(DOY),	as	well	as	local	time	(LT)	or	GMT.	To	
scroll	ahead	to	the	next	month	use	(>)	or	to	the	next	year	use	(>>).	
	

The Calendar option 
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Plotting	RAW	Data	(a	quick	look	at	the	data)	
	
Logpeek	can	plot	raw	data	if	it	is	available.	Check	the	RAW	box	and	the	DSs:	1	(or	any	datastream	to	
plot)	before	loading	the	data	from	a	.zip,	.ref	or	.cf	file.	Verify	that	the	Only	SOH	Items	option	is	
unchecked	since	selecting	this	option	will	force	logpeek	to	only	plot	the	SOH	channels	and	will	
override	the	selection	of	any	other	data	streams.	Selecting	the	RAW	data	option	will	plot	each	
channel	of	the	selected	data	stream	in	a	separate	window	in	addition	to	plotting	the	SOH	data	in	the	
main	display	window.	If	mass	position	voltages	are	also	plotted,	the	color-coded	mass	position	
voltages	and	mass	position	re-centers	(white	dots)	will	be	plotted	in	the	same	window	as	the	raw	
data	as	shown	below.			

Waveforms from a .ZIP file	
	
To	zoom	in	on	a	section	of	the	raw	waveform	data,	you	must	select	and	zoom	in	on	the	desired	time	
window	in	the	main	SOH	window.	CTLR-clicking	in	either	window	brings	up	a	vertical	time	guide	
in	both	the	raw	data	window	and	the	main	SOH	window	to	aid	in	zooming	in	on	a	section	of	data.	
Any	zooming	done	in	the	main	SOH	window	is	reflected	in	the	raw	data	window.		

Zoomed-in waveforms from a .ZIP file	
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Main window and waveform window (blue highlighted box) with vertical time guide (yellow line) 
	
Using	Time-Power-Squared	Plots	
Time-Power-Squared	(TPS)	plots	of	the	raw	data	in	.zip,	.ref,	and	.cf	files	can	also	be	plotted.	Check	
the	TPS	box	at	the	left	of	the	GUI	as	well	as	the	DSs	to	plot.		These	plots	display	the	average-
amplitude-squared,	computed	every	five	minutes	over	the	entire	time	range	displayed	in	the	main	
plot.	Each	horizontal	line	contains	one	entire	day	of	data	from	0000	–	2400	GMT.	Each	5-minute	
block	is	color-coded	according	to	the	average	amplitude	of	that	period.	If	one	or	more	days	of	data	
are	missing	logpeek	plots	a	black	square	for	each	day.		
	
There	are	four	Average	Counts	ranges:	Antarctic,	Low,	Medium,	and	High.	You	can	select	the	range	
by	using	an	“A”,	“L”,	“M”,	or	“H”	radio	button	in	the	plot.	Tables	of	color	values	are	shown	below	and	
a	color	scale	is	also	shown	in	the	TPS	plot	window.	Each	color	is	a	range	and	represents	all	values	
between	the	selected	color	and	the	next	lowest	color.	For	example	a	red	color	in	the	Low	color	
scheme	is	anything	between	+/-	20,000	–	200,000	counts.	
	
Antarctic 
Color	 Average	Counts	
Dark	Gray	–	Black	 No	data	
Dark	Blue	 +/-	10		
Cyan	 +/-	100	
Green	 +/-	1000	
Yellow	 +/-	10,000	
Red	 +/-	100,000	
Magenta	 1,000,000		
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Light	Gray	-	White	 >	+/-	1,000,000	
	
Low 
Color	 Average	Counts	
Dark	Gray	–	Black	 No	data	
Dark	Blue	 +/-	20		
Cyan	 +/-	200	
Green	 +/-	2000	
Yellow	 +/-	20,000	
Red	 +/-	200,000	
Magenta	 2,000,000		
Light	Gray	-	White	 >	+/-	2,000,000	
	
Medium 
Color	 Average	Counts	
Dark	Gray	–	Black	 No	data	
Dark	Blue	 +/-	50		
Cyan	 +/-	500	
Green	 +/-	5000	
Yellow	 +/-	50,000	
Red	 +/-	500,000	
Magenta	 5,000,000		
Light	Gray	-	White	 >	+/-	5,000,000	
	
High 
Color	 Average	Counts	
Dark	Gray	–	Black	 No	data	
Dark	Blue	 +/-	80		
Cyan	 +/-	800	
Green	 +/-	8000	
Yellow	 +/-	80,000	
Red	 +/-	800,000	
Magenta	 8,000,000		
Light	Gray	-	White	 >	+/-	8,000,000	
	
Click	on	a	point	to	display	the	5-minute	average	counts	in	the	status	bar.	CTRL-click	on	a	point	to	
display	a	vertical	time	rule	in	the	data	plot	window	and	show	the	5	minute	average	counts	in	the	
status	bar	of	the	TPS	plot.	This	feature	can	be	useful	for	marking	where	to	zoom	in	on	the	data	as	
well	as	comparing	the	raw	data	with	the	TPS	plot.	Mass	re-centers,	earthquakes,	and	data	spikes	
will	show	up	as	higher	counts.	These	plots	provide	a	quick	way	to	assess	data	for	quiet	and	noisy	
time	periods.	
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TPS plot – the red squares near the middle of the plot are an earthquake 
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Quality	Checking	the	Data	
	
During	a	service	run	the	following	points	should	be	reviewed	to	determine	the	overall	health	of	the	
station.		
	
Power		
Look	at	the	battery	voltage.	Are	the	solar	panels	(if	used)	recharging	the	battery?	Notice,	in	the	
example	below,	how	the	battery	voltage	(with	the	help	of	the	solar	panel)	increases	during	the	day	
(along	with	the	temperature	shown	in	light	blue)	and	discharges	slowly	at	night.	How	much	is	the	
battery	discharging	at	night?		Is	the	battery	discharging	at	an	appropriate	rate	if	not	using	solar	
panels?		
	

Temperature (upper), battery volts (middle), and backup battery (lower) 
	
Below	is	an	example	of	a	faulty	power	system.	Either	the	charge	controller	or	solar	panel	is	not	
working	properly,	or	there	is	a	poor	connection	in	the	wiring	or	connectors.	The	figure	shows	a	
battery	that	is	slowly	discharging	and	is	either	disconnected	or	not	taking	a	charge	from	the	solar	
panel.	Note	how	the	voltage	keeps	decreasing	even	though	temperature	increasing	(light	blue)	
indicates	that	the	solar	panel	should	be	receiving	sunlight	(verified	with	the	time	mark	at	the	
bottom	of	the	plot)	and	charging	the	battery.		

 
Example of a fault in the power system – voltage drops until the system shuts down 

 
Mass	Positions	
The	mass	position	amplitudes	plot	as	colors	near	the	bottom	of	the	GUI	(if	selected).	Cooler	
colors	(blue)	are	low	numbers	and	warmer	colors	(red)	are	higher	numbers.	Click	on	a	dot	
to	display	its	channel	and	voltage	information	in	the	status	bar.	
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Mass positions with data for the selected time shown in the status bar 
 

Mass	position	voltages	that	are	out	of	range	(hot	colors)	can	be	brought	back	into	range	by	
a	re-center	pulse	(white	dot)	as	shown	in	the	example	below.	After	the	re-center	the	mass	
position	voltages	return	to	normal	(cool	colors).	Make	sure	the	appropriate	mass	position	
voltage	range	is	selected	for	the	type	of	sensor	used.		See	the	Options	pull-down	menu.		
 

Mass re-center pulse (white dot) brings channel 2 mass position voltage back into range.  
 
Mass	Position	Problems	
The	example	below	shows	raw	waveform	data	from	a	sensor	where	the	E/W	mass	is	
pegged	and	the	N/S	mass	is	drifting	out.		A	mass	re-center	pulse	(white	dot)	fixed	the	
problem.		
	

	
	

Mass positions pegged and drifting, fixed by a re-center pulse 
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Gaps	in	the	Data	
Sometimes	the	information	plotted	in	logpeek	appears	to	be	missing	information.		In	the	
example	below	the	SOH	information	disappears	in	the	middle	of	the	figure	and	only	the	
events	plots	are	continuous.	This	kind	of	problem	can	happen	if	the	data	were	not	
completely	downloaded	from	the	compact	flash	disk.	

Some missing data due to incomplete downloading from the cf card 

	
The	data	should	be	re-downloaded	from	the	original	disk	using	Neo.	The	example	below	
shows	the	same	data	and	time	frame	with	all	of	the	expected	data	plotted.		
	

All data is plotted after another try at downloading using Neo 
	
 
 

!

!
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Phase	Errors	
Look	at	the	range	of	the	phase	errors.	Often	phase	errors	are	seen	that	are	too	small	to	
affect	the	data.	Only	phase	errors	larger	than	the	½	the	sample	interval	may	affect	the	data.	
For	example,	if	data	are	recorded	at	40sps,	the	sample	interval	is	1/40sps	=	0.025	seconds.	
Therefore	errors	of	<	0.0125	seconds	(12.5	milliseconds	or	12,500	microseconds)	can	be	
disregarded	while	those	larger	than	this	should	be	marked	as	timing	questionable.	
	

Phase errors much less than ½ the sample interval for 40 Hz data 
 

This large phase error should be investigated further, as it is greater than ½ the sample interval 
for 40 Hz data 

 
GPS	Locking	
Check	that	the	GPS	is	locking	and	unlocking	regularly.	The	pattern	seen	in	logpeek	depends	
on	the	type	of	GPS	receiver.		The	saw-tooth	example	below	is	from	an	older	receiver.	The	
clock	turns	on	and	locks	once	each	hour.	The	GPS	is	unlocked,	the	clock	turns	on,	registers	
that	it	is	unlocked,	locks,	and	then	20	minutes	later	unlocks	and	turns	off.		
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GPS turns on and locks (green dot) – unlocks and turns off (red dot) 20 minutes later 
	
Some	newer	receiver	models	allow	the	clock	to	lock	almost	instantly	after	powering	on	
resulting	in	a	different	lock/unlock	pattern	as	shown	below.		Note	the	missing	GPS-UNLK	
dot.		The	duration	of	time	that	the	clock	is	locked	is	20	minutes	in	both	figures.	The	type	of	
clock	is	identified	in	the	log	file;	logpeek	lists	it	in	the	lower	left-hand	box	of	the	main	
window.			
	 	

GPS receiver locks instantly (green dot) and turns off 20 minutes later (red dot)  
	
Below	is	an	example	where	the	clock	fails	to	lock	for	a	period	of	time	and	then	locks	again.	
If	this	happens	at	the	same	time	on	several	stations	in	the	same	network	it	could	be	
indicative	of	several	factors	including	a	satellite	outage	or	poor	satellite	reception.	
	

GPS loses lock for 2 hours and then resumes normal operation 
	
The	example	below	shows	that	there	is	no	communication	between	the	external	GPS	
module	and	the	RT130.		After	this	occurs,	the	RT130	tries	to	wake	up	the	GPS	every	10	
minutes.	Most	likely	the	clock	and/or	clock	cable	will	have	to	be	replaced.	
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DAS loses communication with the GPS module – DAS sends GPS on and off commands every 
10 minutes (red and green dots) trying to wake up the GPS 

 
An	example	of	a	jittery	clock	is	shown	below.	These	errors	are	described	differently	for	
different	versions	of	RT130	firmware.		For	firmware	versions	3.0.0	or	earlier	they	are	
labeled	as	“EXTERNAL	CLOCK	WARNING	1PPS”	as	shown	in	the	upper	example	below.	For	
firmware	3.4.0	(or	later)	the	errors	are	labeled	“EXTERNAL	CLOCK	ERROR	–	SUSPENDING	
DRIFT	CORRECTION”	as	shown	in	the	lower	example	below.	These	errors	are	likely	the	
result	of	a	weak	satellite	signal	to	the	GPS.	If	this	problem	is	caused	by	a	minor	problem	
with	the	GPS	constellation,	the	same	problem	will	occur	on	nearby	stations	that	“see”	the	
same	patch	of	sky.	These	errors	could	also	be	due	to	a	clock	going	bad	and	in	that	case	the	
clock	will	most	likely	have	to	be	replaced.		
	
	

Jittery clock lock/unlock producing 1PPS warning (firmware earlier than 3.4.0) 
 
 

Clock	locks/unlocks/locks	in	less	than	
1minute 
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Same behavior as above resulting in External Clock Error – Suspending Drift Correction 
message (firmware 3.4.0 or later) 

	
Continuous	GPS	mode	
Below	shows	an	example	where	information	seems	to	be	missing	for	the	GPS	lock-unlock	
field.	One	way	this	can	happen	is	if	the	GPS	was	left	in	the	continuous	setting	instead	of	the	
cycled	setting.			
	
The	logpeek	screen	below	shows	a	section	where	there	is	a	single	data	point	for	the	GPS	
powering	up	and	then	one	point	for	the	GPS	unlocked	and	one	point	for	the	GPS	lock.	The	
phase	error	messages	are	very	regular	and	very	small	(+2	to	-3microseconds).	The	main	
reason	that	most	experiments	do	not	adopt	the	continuous	on	GPS	setting	is	that	it	draws	
more	current	and	therefore	uses	more	power.		
	

GPS turns on and although the clock locks and unlocks once, it is in continuous mode. 
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Clock	Failing	
A	more	common	reason	for	what	appears	to	be	missing	data	on	the	GPS	LK-UNLK	line	is	
that	the	clock	is	missing	some	locks.	This	may	be	due	to	minor	issues	with	the	constellation	
or	sky	view	or	can	be	indicative	of	a	more	serious	problem	if	the	condition	worsens.	In	the	
example	below	the	station	started	out	with	consistent	clock	locking	and	then	transitions	to	
the	clock	failing	to	lock	more	often	until	by	day	2010:186	the	lock	fails	to	lock	for	several	
days.		
	
The	timing	is	suspect	from	2010:186-2010:189,	due	to	intermittent	and	irregular	clock	
locks,	therefore	these	data	were	marked	“timing	questionable”,	using	fixhdr.			Without	
regular	clock	locks	and	phase	error	reports	it	cannot	be	determined	if	the	timing	is	
accurate	within	the	precision	desired.	In	a	case	like	this	the	GPS	location	should	be	
inspected	to	ensure	that	there	is	a	clear	sky	view.	By	comparing	the	number	of	satellites	
obtained	with	a	hand-held	GPS	to	the	number	shown	in	the	DAS,	it	can	be	determined	if	the	
sky	view	is	unobstructed.		The	GPS	should	be	replaced	if	the	sky	view	is	unobstructed	and	
logpeek	shows	the	behavior	below.			
	

GPS clock locks intermittently and may be failing 
	
DSP	CLOCK	DIFFERENCE	errors	
DSP-CLK	DIFF	of	0	secs	and	0	msec	coupled	with	DSP	CLOCK	SETS	with	no	time	change.	
DSP	sets	are	scheduled	to	occur	on	1	January	and	1	July	(days	001	and	182	–	see	below).	
	

!
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Scheduled DSP-CLK SET at day 182 
	
Another	example	of	a	zero	time	difference	for	DSP	CLOCK	SET	is	when	a	GPS	loses	a	lock	or	
is	unable	to	lock	(see	below).	It	will	turn	the	clock	off	with	the	SOH	message	“EXTERNAL	
CLOCK	POWER	IS	TURNED	OFF”,	wait	five	minutes	and	then	try	again.	When	the	GPS	finally	
gets	a	lock,	it	issues	a	DSP	set	message	with	zero	time	change	as	well	as	a	DSP-CLK	DIFF	of	
zero.	There	is	no	problem	with	data	collected	during	this	time	period	but	it	may	indicate	
that	the	clock	is	going	bad,	warranting	a	replacement	during	the	next	service	visit.	
	

DSP CLOCK SET when GPS regains a lock 
 

!
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Possible	Timing	Problem	errors	
If	logpeek	suspects	there	are	possible	timing	errors,	as	shown	in	the	extreme	example	
below,	there	will	be	a	message	highlighted	in	yellow	in	the	status	bar	when	the	file	initially	
loads.	This	may	or	may	not	be	true,	and	merits	further	investigation.	This	message	will	
disappear	while	viewing	the	log	file,	and	a	Timing	Error	window	will	appear	with	a	list	of	
data	that	contain	possible	timing	problems.		
	

Timing errors identified by logpeek 
	
Year	2000	Start	Dates	
In	some	circumstances	the	DAS	will	start	recording	SOH	information	before	the	clock	has	
locked.	Thus	the	DAS	does	not	know	what	time	it	is	-	resulting	in	the	ZIP	file	having	a	name	
starting	with	200001	as	shown	below.	This	is	commonly	the	result	of	a	station	losing	and	
then	regaining	power	and	having	the	RT130	backup	battery	fail	as	well.	Once	the	power	is	
back	on	the	DAS	(not	knowing	that	it	doesn’t	know	the	correct	time)	starts	recording	SOH	
messages	and	automatically	restarts	acquisition	even	if	the	clock	has	not	yet	locked.	
	
As	soon	as	the	clock	locks,	the	SOH	and	data	are	marked	with	the	correct	time.	Logpeek	will	
plot	2000	SOH	data	in	year	the	2000	along	the	time	scale	marked	at	the	bottom	of	the	
logpeek	main	window.		
	
The	year	2000	information	looks	like	it	is	first	in	the	order	of	events,	but	upon	closer	
inspection,	it	becomes	clear	that	the	files	were	not	recorded	in	2000.		If	you	look	at	the	file	
creation	date	using	Finder	(on	a	Mac)	or	using	ls	–l	from	the	command	line,	you	can	see	
when	the	file	was	actually	created	and	determine	where	it	fits	into	the	greater	logfile	
picture.		In	general,	all	data	marked	as	year	2000	that	is	generated	during	this	time	period	
before	the	clock	locks	should	not	be	archived	and	the	resulting	channel-day	volumes	from	
the	year	2000	should	not	be	archived	either.		No	other	timing	correction	or	notation	is	
needed.	
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Files labeled as 2000001.DAS#.ZIP (insert) and logpeek plot showing the gap between data 
with the correct time and data marked as year 2000 

	
	
	
 


